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QUERY 

Introducing QUERY 

Even with the variety of business intelligence (BI) systems that are installed and operational at 

most companies, one of the top challenges reported by SAP end-users is the lack of easy access 

to real-time SAP data in the transactional system. The ability for business users to easily query 

and extract transactional SAP data is critical for many purposes such as: 

• Operational reporting 

• Data fire-fighting driven by business-changes, such as to extract data for mass changes 

• Ad-hoc reporting and prototyping steady-state BI reports 

With Winshuttle QUERY, you can securely and easily extract live SAP data into familiar Microsoft 

Excel and Microsoft Access formats for immediate and accurate analysis. A variety of governance 

features and performance tuning features in QUERY ensure that user-generated queries are 

secure and have minimal impact on the SAP server performance. 

With RUNNER you can view queries that were created in QUERY, change the mapping of those 

queries, and then run them. However, to create or edit queries, you need the full functionality of 

QUERY. 

   

 

 

New Features in Winshuttle QUERY 10.3 

 Queries based on tables can now be stopped during a run with the Stop button. 

 Padding or leading zeros is now an optional feature. 

 Queries can be scheduled in the background in SAP. WFM can process RFC in background 

for multiple-table QUERY scripts. 

 Run-time variables are now supported in query chains.  
 

Getting help in Winshuttle QUERY 

You can click any one of the Help ribbon buttons at any time to obtain assistance and to learn how 

to use QUERY. The Help tab selections are available on all screens. 
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Help ribbon selections 

In the QUERY, the Help tab offers the following items: 

 

 A Getting Started help file. 

 An Advanced User Guide in PDF format, which you can open from within QUERY, print, or 
save to your computer. 

 QUERY release notes that include bug fixes and new features introduced in different 

versions of the product. 

 Auto update button to check for recent product updates and related downloads such as for 

security and critical updates. You can also set up  to automatically check for available 

software updates by using the Auto Update option.  

 Support SHUTTLE information that Winshuttle Support might ask you to generate to better 

assist you to use QUERY. 

 Information about your QUERY version and license. See Activating a Winshuttle license 

for more information. 

 Launch Connect Site button to open the Winshuttle Connect site to update your Connect 

information, such as your password. 

 
 

Winshuttle customer service 

Winshuttle provides a full range of self-service options to assist you in using  effectively. You can 

also contact Winshuttle Customer Support directly by e-mail message or by telephone: 

E-mail: support@winshuttle.com 

In the US, call the Winshuttle at 1-800-711-9798, and then choose option 2 

In the UK, call Winshuttle at +44-208-704-4170, and then choose option 2                     

In addition, you can view the most frequently asked support questions at 

http://www.winshuttle.com/Support-and-Training. 

To read and to share articles and tips and tricks for using Winshuttle products, visit the Winshuttle 

community page at http://community.winshuttle.com.  
 

Viewing the end-user license 

View the end-user license agreement from the Help menu.  
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 Click About  to view product version and licensing information. 

 

 Click View License Agreement to display the End User License Agreement in a PDF format.  

 





 

 

Activating QUERY 

Installing QUERY 

You can install QUERY in only a few minutes. Download and run the installation file from the link 

you have received from your account representative. Follow the on-screen instructions to finish 

the installation.  

Prerequisites to installing QUERY on a client computer 

 SAP GUI release 710 or later must be installed on your workstation. 

 Microsoft Excel version 10 or later 

 Windows 98/NT/2000/XP/Vista/Windows 7.  

Note: Winshuttle software is adapted to Windows 32-bit or Windows 64-bit platforms. Select the 

appropriate Winshuttle installer for your platform 

Installing QUERY 

You can install the software by: 

 Using a CD-ROM 

 Downloading the installation file from the network 

Folder locations 

The new installation will create new product folders. However, you can move the folders to other 

locations. Old scripts and data files are retained in legacy folders. 

Using a CD-ROM 

To install software using the CD-ROM 

1. Insert the CD-ROM in your computer. 

2. Installation begins automatically. 

3. If the installation does not automatically begin, select Start on the task bar, and then 

select Run. Select Browse to go to the CD-ROM drive. Then select Setup to begin the 

installation. 

4. Follow the on-screen instructions to complete the installation. 
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Downloading the installation file from the network 

To install the software by downloading the installation file 

1. Click the link that you received in email. 

2. Download the Setup.exe file and save it on your local drive. 

3. Double click Setup.exe and follow the on-screen instructions to complete the installation. 

4. When the installation is complete, follow the appropriate procedure to activate the 

software. For more information, see "Activating through Winshuttle Connect". 

Begin using QUERY. 

Installing a product by using the single MSI or enterprise set up 

Prerequisites 

When installing MSI in silent mode (enterprise deployment), ensure that Microsoft .NET version 

3.5 SP 1 is installed on the target systems, otherwise the silent MSI installation will abort. 

Installing a major upgrade with the single MSI setup 

For MSI, you need to pass a command line option "SILENTINST" and the value "1" needs to be 

set for it. At the command line 

 msiexec /i "product.msi" /qb SILENTINST=1 

Installing a minor product update by using the single MSI setup 

If you install an update to an existing product installation, you must do so from the command line.  

1. At the command line, set reinstall=all. 

2. Set the command reinstallmode=vomus. In all but the most advanced scenarios, the 

command reinstallmode should be set to vomus. The following is an example of a typical 

command line for setup: 

msiexec.exe /i \product.msi reinstallmode=vomus reinstall=all 

Installing a minor product update by using the single MSI setup 

If you install an update to an existing product installation, you must do so from the command line.  

1. At the command line, set reinstall=all. 

2. Set the command reinstallmode=vomus. In all but the most advanced scenarios, the 

command reinstallmode should be set to vomus. The following is an example of a typical 

command line for setup: 
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msiexec.exe /i \product.msi reinstallmode=vomus reinstall=all 

NOTE: It is critical that you use the command line installation only when a previous version of the 

product already exists on the target computer. If you set the properties when the product does 

not already exist on the computer, the installation appears to run in minor upgrade mode, but 

your application files may not be installed. 

Installing a major release from the command line 

For a new installation where a previous version does not exist, do not set reinstall=all. 

Installing Winshuttle STUDIO 

Winshuttle STUDIO offers three installation options: 

 Upgrade. Select Upgrade to install STUDIO on a computer that already has a previous 

version of TRANSACTION or QUERY and to confirm that your current version of a 

Winshuttle program can be upgraded. If your version of TRANSACTION or QUERY cannot 
be upgraded, you need to choose Custom. 

 Complete. Select Complete to install all available Winshuttle products, including 

TRANSACTION, QUERY, and DIRECT. The files are installed to the default directory, 
C:\Program Files\Winshuttle. 

 Custom. Select Custom to install select Winshuttle products and to choose the destination 

directory. 

Note: On upgrade or re-installation of version 10.0, new document folders (My 

Documents\Winshuttle) will be created with the name TRANSACTION. However, your application 

options will not be re-set to these new paths. If you want to use the new folders, we suggest you 

do that manually. 

To upgrade to STUDIO 

1. Insert the disc into your computer's DVD or CD drive. Installation begins automatically. 

2. If the installation does not automatically begin, click Start on the task bar, and then click 

Run. Click Browse to go to the CD or DVD drive. Then select Setup to begin the 

installation. The first page of the wizard, click Next. 

3. Read the License Agreement page, and if you accept the license terms, click I accept the 

license terms. 

4. Add the user name and company name. 

5. On the Setup Type page, click Complete or Custom. 

6. If you selected custom, on the Product Selection page, select each product you want to 

install. 

7. Follow the instructions. 
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To install STUDIO by performing a complete installation 

1. Insert the disc into your computer's DVD or CD drive. 

2. Installation begins automatically. 

3. If the installation does not automatically begin, select Start on the task bar, and then 

select Run. Select Browse to go to the CD or DVD drive. Then select Setup to begin the 

installation. The first page of the wizard, click Next. 

4. Read the License Agreement page, and if you accept the license terms, click I accept the 

license terms. 

5. Add the user name and company name. 

6. On the Setup Type page, click Complete. Installation begins. 

To install STUDIO by performing a custom installation 

1. Insert the disc into your computer's DVD or CD drive. 

Installation begins automatically. 

2. If the installation does not automatically begin, select Start on the task bar, and then 

select Run. Select Browse to go to the CD-ROM drive. Then select Setup to begin the 

installation. The first page of the wizard, click Next. 

3. Read the License Agreement page, and if you accept the license terms, click I accept the 

license terms. 

4. Add the user name and company name. 

5. On the Setup Type page, click Custom. 

6. On the Choose Destination Location page, do one of the following: 

o Click Change to browse to a new folder 

-or- 

o If you don't want to specify a new folder, click Next. 

Follow the to select the products you want to install. 
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Activating the 15-Day Evaluation Version 

To activate the evaluation copy 

1. On the startup screen, click Activate. 

2. On QUERY license option screen, click Evaluation. Click Next. The Evaluation screen 

appears. 

3. On Evaluation screen, type your name, company name, and e-mail address, and then click 

Next. 

4. On successful evaluation license activation, you have the option launch the application. 

Click to clear the Launch Application check box if you do not want to launch the application 

after license activation. 

5. Click Finish to complete the process. 

NOTE: The evaluation version is valid for only 15 days. When the evaluation period ends, you are 

prompted for an evaluation extension key. Contact your IT department for the extension key. 

Evaluation licenses are limited to 250 records for QUERY. 
 

Activating a Winshuttle license 

Activating a Connect License 

Winshuttle Connect is a program that tracks the assignment and usage of licenses for Winshuttle 

products. To use Connect, you must be connected to the Internet. 

If you are using a Winshuttle product for the first time--and if you know that you have been 

assigned a Connect license--and that the version is 10.3, follow these steps to activate the 

software: 

To activate the software through Connect 

1. Ensure that you have registered with the Connect account.  

On the splash screen that appears the first time you start QUERY, click Connect. 

The Connect Login dialog box appears. 

Type in your user credentials.  

Select the Remember my login check box to open the program again without entering credentials. 

To work offline and to schedule runs, Remember my login must be selected.  

Click OK. The program opens.  
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Migrating to Connect 

If you already have a Winshuttle product license, you must migrate to the Connect license when 

you upgrade your Winshuttle product. To use Connect, you must be connected to the Internet. 

NOTE: After you migrate to Connect, you cannot migrate back to a flex license.  

To migrate your license to Connect 

1. Upgrade from Winshuttle product version 10.2 to 10.3. 

2. Click the program icon. 

3. The Migrate to Connect box appears.  

4. By default, I would like to request Connect access is selected. Click OK to the request for 

migration to your Winshuttle license admin. You will be notified by email when a license is 

available for you. The process may take a few days.  

5. If you do not want to migrate your license, click Do not show this at startup, and then click 

Skip this step.  

The program opens by using the node-locked license. To migrate later, click the Migrate to 

Connect button at the bottom right corner of the home screen. 

6. When a Connect license is available for you, start the program again. 

The Migrate to Connect dialog box indicates that you have a Connect license. 

7. Type in your user name and password. Click OK. 

The program opens. Your license is now a part of Connect.  

8. To ensure that scheduled runs can execute, click Remember Login. 

 

Activating without the Internet 

For a first-time installation of a Winshuttle version 10.3 product, if the computer that hosts your 

node-locked license is not connected to the Internet, you must install a 10.2 license of the product 

before you can upgrade to 10.3. 

Deactivating a License 

To deactivate, or revoke, your license 

 See your Connect license administrator. 
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Activating a Node-locked (Fixed Desktop) or FlexNet  License 

1. On the splash screen that appears the first time you start QUERY, click Activate Product. 

2. On the QUERY license screen, click Node-locked/Network.  

3. Enter the Activation key in the License Activation window, along with the requested user 

information, and then click Activate License. Click Next.  

4. Do one of the following: 

 If connected to the Internet:  

o On successful evaluation license activation, you have the option launch 

the program (selected by default). Click to clear the Launch Application 

check box if you do not want to launch the application immediately after 

license activation. 

-or- 

 If not connected to Internet:  

o Internet Explorer opens. Follow the on-screen instructions to complete 

your activation. 

Note: Location of the license file is dependent on the version of Windows run on the client 

machine: 

For Windows7/Vista: C:\ProgramData\Winshuttle\license 

For Windows XP: C:\Documents and Settings\All Users\Application Data\Winshuttle\license 

 

 





 

 

Setting preferences 

Automating your logon 

You can automate your logon, that is, create an auto-logon file (ALF), to automatically enter SAP 

logon information each time you use a query file, and to logon on to the system during scheduled 

unattended runs. An ALF file stores your SAP logon information in an encrypted file format. 

ALF Management 

Use ALF Management to create an Automated Logon File (ALF) to automate your log on to SAP. 

You can use an ALF to schedule a run or when you want to use the same logon information each 

time you run one of your script files. For more information about scheduling, see "Scheduling a 

Run". When you save credentials, you are not asked to provide a user name and password for 

that system and are automatically logged in to the system. 

Select Tools from the Main Menu, and click Options button to display the Options dialog box, with 

the Application Defaults shown. Then click ALF Management to display the settings shown below. 

To create or modify an ALF 

1. Choose one of the following responses: 

Click Capture to create a new ALF file. When the SAP SERVER logon dialog box is 

displayed, type the logon information for SAP to capture the ALF information automatically. 

This is the easiest and error-free way to create an ALF. You can also mark the Use Logon 

Group check box and type the Logon Group and Message Server Host settings to save a 

logon group in the ALF. 

-or- 

Click Open to display an existing ALF file to make changes to the file. Click Test to perform 

a test of your log on information. A message is displayed to confirm that your log on was 

successful. 

2. Click Save to store the ALF when you are finished. NOTE: ALF files are encrypted, which 

makes it difficult to open and read your SAP password and other information. However, if 

the ALF file is accessed, it could be used to log on to SAP by any other person who has 

authorization to use QUERY. For this reason, we strongly recommend that you protect your 

ALF file, either by using Windows system encryption to prevent others from using it under 

their user name, or by storing the file on removable media that is password protected. 

The ALF fields 

SAP System Name Specify the SAP system name 

Application Server Host Enter the host name. 
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System number Specify the system number. 

Use Logon Group 
Select this check box to update 

logon group information. 

Logon Group Type the auto logon group 

information. 

Message Server Host Type the message server host 

information. 

Client Enter the client number. 

User name Specify the user name. 

Password 
Specify the SAP password for 

the user. 

Language 
Specify the language that the 

system should use. 

EP URL 
Specify the enterprise protocol 

URL. 

Use SSO1 

Select this check box to enable 

single sign on. With single sign 

on, the SAP system uses the 

Windows credentials (user 

name and password) for each 

user.  

Partner Specify this connection 

parameter if you select single 

sign on. 

Auto Logon File 

After you capture system data 

and logon credentials and save 

the file, the path and name of 

the .alf file appear. 

 
 

 

SAP defaults 

To set the default SAP logon 

1. On the Tools tab, click Options. 

2. Click SAP logon default. 
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3. Specify default SAP logon languages. 

4. If you want, select Remember last logon password. 

5. Specify a customized path for the SAP logon .ini folder. You can place the SAP logon file at 

this location. 

For 64-bit operating systems, SAP logon defaults display an option to select the Single Sign On 

(64 bit) configuration file. 

User data formats 

In QUERY, you can specify whether data is displayed as raw data or as formatted data. 

Use regional settings. Select this check box to ensure that dates and numbers are downloaded 

and displayed in accordance with the regional settings on your computer. Regional settings apply 

to Excel, text, and XML files. Regional settings also apply to data that is displayed in QUERY, such 

as previewed text and values displayed through F4. 

Access and SQL Server databases use their own data formats and do not display data in the 

regional setting format. 

You specify regional settings on the Regional and Language Options dialog box that is available 

through Control Panel on your computer. 

Clear the Use regional settings check box. Clear this check box to download raw data in Excel, 

text, and XML files. Raw data is displayed in QUERY, such as in previewed text and values 

displayed through F4. Access and SQL Server databases use their own data formats. 

Dates. You can specify the download format for dates in the Date Format box. The date format 

selected is used to display dates in Excel, text, and XML files, in Access and SQL Server 

databases, and in preview and F4 values that are displayed in QUERY. 

 
 

Client Connection Settings 

Depending on your firewall and email policies, your organization may select to route email 

through the internal email server or the Winshuttle default email server. 

 Attachments can be added to email messages sent through an internal server. 

 No attachments can be attached to messages that are routed through the Winshuttle 

default email server.  

To set up email connections 

1. On the Tools tab, click Options. 

2. Click Client Connection Settings. 

3. Select Winshuttle default mail or Internal e-mail server. 
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For an internal account, select settings for the account that should receive the results: 

o Microsoft Exchange Server: Provide the name of the Microsoft Exchange Server. 

o Server port number: By default, the server port number is 25. Contact to your IT 

department to confirm the port number for your organization. 

o Attachment size limit (MB): Specify the maximum attachment size. The attachment 

size should not exceed the size allowed on the exchange server. 

o From Email address: Specify the Exchange server e-mail address to which the message 

should be sent. 

Note: Application sends the e-mail message with attachment (with the configuration specified) 

only when the user is logged on to the system, with his or her domain authentication. 

Proxy settings for Connect 

Proxy settings are used for Connect and are similar to Internet sittings. Consult your system 

administrator before you change any proxy settings. 

To configure a proxy setting 

1. Click Proxy Server Settings. 

2. Do one of the following: 

 Click Use system proxy. Click OK.  

 -or- 

 Click Custom proxy. 

1. Select the Authentication Required check box. 

2. Type in the username and password. Click OK. 
 

Specifying QUERY script properties 

QUERY script properties in QUERY comprise the information about your file. When you start a new 

query, you are prompted to specify these properties for the file. You can update this information 

for a file any time you have the file open by clicking the Script properties button. 

The QUERY Script Properties dialog box appears when you create a new query file, but you can 

also edit file properties for the current file by clicking the QUERY Script Properties button . 
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To enter or edit properties of your script 

1. Do one of the following: 

 Click New. 

-or- 

 Click the QUERY Script Properties button. 

2. Enter options as desired. Click OK. 

Query script properties 

Data source Specify which of the following data sources you want to use in the query: 

 Tables 

 Infosets/SAP Queries 

 Logical databases 

Title Specify a title for your query. A title is required information. An example of a title for a 

query is "Vendor Account Balance Report NA.” 

Lock query file Select the Lock query file box to apply a password to the query file. 

Password and Confirm Password In the Password box, type a password for the file, and then in 

the Confirm Password box, type the same password. 

SAP system Indicates the SAP system on which the query resides. The information in this field is 

supplied by the system and cannot be edited. 

Created by Indicates the user who creates the file. The information in this field is supplied by the 

system and cannot be edited. 

Date and Time Indicates the date and time when the file is created. 

Purpose of file Specify a reason for the file. An example of a reason is “Provide a report for a 

vendor in North America with past due balances.” 

Comments Enter comments about the query file. 

 





 

 

QUERY 
 





 

 

The QUERY screen 

QUERY provides a look and feel that is similar to other Winshuttle products and to other 

programs that you use every day. 

Starting with QUERY 

You open QUERY to see the Most Recent Files and Favorites pane. From Most Recent Files 

and Favorites, you can create a new query or open an existing query. You can view and 

open files from the list of most recently used queries and from a list of files that you have 

specified as your favorites. 

The Back button 

At any time, if you need to return to a previous screen or to advance to the next 

stage in some processes, click the Back button, which is always available at the top of the 

QUERY screen. 

The Open button 

Click Open to open an existing query. 

The Close button 

If you need to exit QUERY at any time, click the Close button. You are prompted to 

save any open file. 

The Change button 

 

With the Change button, you can quickly move from the current query file to select 

another existing query file. 

Tabs 

Tabs contain buttons that help you access functionality. The available buttons change as 

the steps of the query process change. 



Winshuttle QUERY User Guide 
 

 

File tab 

 

Contains the New, Open, Save, and Save As buttons. 

Tools tab 

 

Displays buttons for the Log Viewer, Scheduler, and Options. When QUERY is in the Select 

stage, the Search button is also available. 

Help tab 

 

Displays buttons for online Help, User Manual, which is available in a PDF format, Release 

Notes of your QUERY installations, Automatic Update of QUERY, Support Information to 

help Winshuttle to assist you, and information About QUERY. For deployments that use 

Connect, a button to start the Connect site. 

The three- step process and the three-panel screen 

 Everything you do in QUERY centers on the three-step process of Select-Map-Run, 

which corresponds to the three-pane screen. Most tasks in the QUERY return to 

the three-pane screen. 

 You create queries, map the fields to columns in result files, and run the queries 

from these panels. 

 To create a query you drag-and-drop tables from the data dictionary into the 

query builder area. 

 You can click the Search in Data Dictionary button to search for tables and fields in 

the Winshuttle Data Dictionary and available SAP tables. 

 

 You can mouse over a table name to see a text explanation of the purpose of the 

table. 

 To see the complete field text that explains field names in the tables, drag a 

border to enlarge tables. 

 To delete a table from the query builder area, click the red x. 

 To remove a field from the query builder, right-click the field, and then click 

Remove Item on the shortcut menu. You can also click the check box for that field 

in the table. 



 

 

 At any time after you complete a step in the query building process, you can 

update your work by clicking one of the update buttons in the three-pane screen. 
Click Update query or Update mapping. 

 To preview a query, click the Show query preview tab. 

  

The Select and Map panes. 

The three-pane screen 

Everything you do in QUERY is centered on the three-pane screen. You can view queries 

in the Select pane, modify them in the Run pane, and run queries in the Run pane. In 

QUERY, you can view an existing query, update the mapping, and then run the query. 

Tabs 

Tabs contain buttons that help you access functionality. The available buttons change as 

the steps of the query process change. 

File tab 

 

Contains the New, Open, Save, and Save As buttons. 

Tools tab 

 

Displays buttons for the Log Viewer, Scheduler, and Options. When QUERY is in the Select 

stage, the Search button is also available. 

Help tab 
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Displays buttons for online Help, the user guide, which is available in a PDF format, 

Release Notes of your QUERY installations, Automatic Update of QUERY, Support 

Information to help Winshuttle to assist you, information About QUERY, and if your 

environment includes Winshuttle Connect, a button to Launch Connect. 

Other buttons 

 Other buttons are available when you have any query open. 

 With the File Properties button, you can update the file properties information that 

describes your file at any time . 

 The Publish query file button provides a way to embed a query file in an Excel file 

or template . 

 The Show Query button, which shows the SQL statement for the query . 

 With the Favorites button, you can add your query to the Favorites list in the 

Recent Files and Favorites pane at any time. The Remove favorites button 

removes files from the Favorites list . 

Status bar 

The following items are displayed in the status bar: 

 

 The status of the SAP connection, whether connected or disconnected, is indicated 

on the left-hand side of the status bar. 

 The version of the Winshuttle function module available on your computer. 

 The current language of QUERY is indicated on the right-hand side of the status 

bar. Select English, French, or German, Dutch, or Spanish. The changes appear 
when QUERY is restarted. 

 

 

 

 



 

 

Introduction: Getting started with QUERY 

Extracting information in QUERY centers on a three-step process: Select-Map-Run, so that you 

can easily build and execute your query. After each step of the process, you return to the three-

pane screen. 

You can output your query to Excel, Access, text, or SQL Server files. For the purposes of this 

demonstration, we will output to an Excel file. 

Production servers versus non-production servers 

When you first create a query, it is good practice to build and test the query on a non-production 

servers. 

Creating a query 

To begin a query 

1. In QUERY, click New. 

In the Select pane, click Create Query. 

 

The SAP logon pad appears. Select the server on which you want to build a test query. It is good 

practice to test only on a non-production server. 

To set the system as the default for every logon, select Use selected system as default. Click OK. 

Under User Data, enter your user name and password. Click OK. The QUERY File Properties dialog 

box appears. 



Winshuttle QUERY User Guide 
 

32 

 

 

o Select the type of data source you want, whether tables, infosets and queries, or logical 

databases. Note that infosets and SAP queries must be enabled by the administrator 

before you can use them. 

o Specify a title, reason for the file, and add comments as needed. For example, a title 

might be “Materials type” and a reason for the file might be “List material types 

acquired in past month.” 

o Add a title and the reason why the file was created, if you want. 

o QUERY supplies the SAP system, the alias of the person who created the file, and the 

time and date on which the new query was started. 

If you want to protect the query with a password, click Lock Queryfile, and then enter and confirm 

a password. Click OK. 

Authorization issues 

If you are not able to complete a transaction and receive authorization errors, ensure that you 

have Winshuttle Function Module installed. Winshuttle products use remote function calls to 

access SAP. These add another layer of security to your processes. Verify that you are authorized 

to access the appropriate Winshuttle authorization objects by clicking the Authorization Object 

button on the Tools tab. Consult the Authorizations topic for more information.  

.ini issues 

If you have problems logging on and receive .ini errors, check the location of the .ini file. You may 

need to point SAP to your .ini file.  
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Introduction: Building a query 

Before you build a query, you must decide what information you need and what data source 

contains that information. Be specific about what you extract. Retrieving a narrow range of data 

improves response time and reduces unnecessary information. 

If this is your first use of QUERY, you must synchronize the Winshuttle Data Dictionary. The 

Winshuttle Data Dictionary is specific to the data source you selected, whether Tables, or 

Infosets/SAP Queries, or logical databases. Each of these contains the most frequently used SAP 

tables, Infosets, or Queries and logical databases for that source. These components are 

organized organized according to functional area, such as Materials Management, Sales and 

Distribution, Human Resources, and Production Planning. Tables that are relevant to specific 

transaction codes are organized under a "tcode" item. 

To synchronize the data dictionary 

 Do one of the following: 

o In the data dictionary pane, right-click Winshuttle Data Dictionary. On the shortcut 

menu, click Synchronize. 

-or- 

o Drag a table into the Query Builder area. The table synchronizes automatically. 

The names in the pane change from red to black when the tables are synchronized. Icons indicate 

cluster, pool, and transparent tables, and even table views. 

  

Data dictionary before synchronization and after synchronization. 

For the purposes of this example, we will use the MARA and MAKT tables. 
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To add tables to the query builder area 

 Do one of the following: 

o Drag-and-drop the tables, Infoset, query, or logical database you want into the query 

builder area, or double-click a table name.  

-or- 

o Click the Search in Data Dictionary button below the data dictionary. Click Search by 

Table, and enter a table name or a table description. Click Search. Select the table you 

want from the list that appears and click Add Selected Table to Query Builder Area. 

 

To build a query 

1. In each table, select the fields that you want to query. 

The field names appear in the criteria pane.  

2. To specify criteria for a field, click Selection. The default selection type is Run Time. If you 

want the criteria to be fixed, set the selection type to Fixed. The WHERE clause builder 

opens. Do this for all your fields. 

3. Click the Back button to move to the mapping stage. When you are prompted to save 

the file, click Yes. 

4. In the Save As dialog box, enter a name for the query file, and click Save. 

You are now back in the three-pane screen, and are ready for the mapping stage. 
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The map pane of the three-pane screen after a query has been built and saved. 
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Introduction: QUERY templates 

QUERY provides query templates which guide you through the most common queries used for 

accounting, finance, material master transactions and help you to customize your own queries. 

Templates are made available online and can be downloaded to build queries. You can browse all 

templates or browse only Excel templates or only QUERY scripts. When you select a file, the file 

name, description, and size. User assistance documents, such as step-by-step guides and videos, 

called collateral, are available by clicking the in the product screen. 

Creating a query using Winshuttle Templates 

1. On the Select pane, click Create Query Using Winshuttle Templates. 

2. To use a template, do one of the following: 

o To use a QUERY script template, double-click the template or select the script and click 

Create. Save it to your computer. You can update this query as required. 

-or- 

o To use an Excel template, download the template to your computer by double-clicking 

the template or select the script and click Create. 

3. Start the Excel template or open the query file that is embedded inside the Excel template. 

If you open query script, the embedded query opens. You can modify the query according 

to your requirements and run it. 

4. If you open the Excel template, you can use the QUERY add-in for Excel to download data 

into the template. 

Firewall issues 

If you experience difficulty downloading templates, your company's firewall might be preventing 

the downloads. Contact your IT department. You can also contact Winshuttle support to have the 

template sent to you through an e-mail message. 
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Introduction: Mapping your fields to a result file 

With Winshuttle QUERY, you can create modify a template for an output file so that when the 

query runs, the extracted data are arranged in the output file the way you want. Output files 

include Microsoft Excel, Microsoft Access, text, or Microsoft SQL Server files. 

To map fields to an output file 

2. Drag the field to the column where you would like the results to appear. For each mapped 

field, the query indicates which column it has been added to. 

 

3. Click Save. You are prompted to save the preview. Click Save again. 

4. Click the Back button. You are now back in the three-pane screen and are ready to run 

your query. 

At any time throughout the three-step process, you can add a query to your favorites list so that 

you can quickly find the query. Click Add Favorites. The file then appears in the Recent Files and 

Favorites pane. 
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Introduction: Running queries 

The result file you specified is ready. You can add a reason for the run in the Run Reason field. 

You can select to run the query now or later. 

To run the query 

1. Click Run. 

 

 

The Excel file opens and the results are displayed. 

2. Click the Back button . You are prompted to save the .qsq file. Click Save. The Most 

Recent Files and Favorites pane appears. 

 The most recently run query appears at the top. You have completed your first query in QUERY. 

 

Stopping a query run 

You can stop a running query by clicking the Stop button . The stop functionality is 

useful if you inadvertently begin a large run. 

Note: You can stop a running query, only if it has been created with tables as the data source. 

You cannot stop a query run that contains InfoSets, SAP queries, or logical databases.  
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Introduction: Infosets, SAP queries, and logical databases 

SAP queries and Infoset queries are SAP end-user query reporting tools. They are valuable tools 

for generating customized reports. In particular, business users derive real benefit from them, 

because they would otherwise rely on programming staff to generate reports from the system. 

Security handling 

The inbuilt logic for security inside the LDBs is respected by Winshuttle QUERY. There is no other 

additional layer of security. 

The table containing authorization objects for fields (see Authorizations on page 108) is used in 

securely extracting records for Infoset/SAP Queries. 

Security is applied on Infoset/Query corresponding to the presence of table and field in 

authorization table. For example if MARC-WERKS is present in Infoset/Query then its existence is 

checked in single table authorization table. If it exists then data is filtered accordingly. 

There is difference between how it is handled for Infoset query and SAP query: 

 For Infoset query: It does not depend whether you have selected a field as output or not. 

 For SAP query: Security will be applied only for output fields. It is not applied if a field is 

just a selection field. 

To access SAP queries and Infosets which are already created in SAP, use Winshuttle QUERY. 

Introduction to LDBs 

Logical databases are special ABAP programs that retrieve data and make it available to 

application programs. The most common use of logical databases is still to read data from 

database tables by linking them to executable ABAP programs. You can use LDBs with Winshuttle 

QUERY only if the Winshuttle Function Module is installed on the SAP server you use. 

Security handling 

The inbuilt logic for security inside the LDBs is respected by QUERY. There is no other additional 

layer of security. 

To access SAP queries and Infosets which are already created in SAP, use  QUERY. 

 

 



 

 

Selecting 

Data sources 

Your query starts with your selection of a data source in the properties dialog box. With each data 

source that is available to QUERY, you can use the three-step process to create a query, map it, 

and run query. 

SAP and Custom Tables 

The Winshuttle Data Dictionary displays the most commonly used tables. The tables display the 

following information: 

 Functional area, such as Finance Accounting, Human Resources, Production Planning. 

 A node for transaction codes which lists the tables used in common transactions. 

 Descriptive text to make it easier to identify the table. 

 Unique icons to distinguish different table types, such as cluster, pool, and transparent 
tables, and also table views. 

Logical Databases (LDBs) 

Logical databases are special ABAP programs that retrieve data and make it available to 

application programs. The most common use of logical databases is still to read data from 

database tables by linking them to executable ABAP programs. 

You can use LDBs with QUERY only if the Winshuttle Function Module is installed on the SAP 

server you use. 

Security handling 

The inbuilt logic for security inside the LDBs is respected by Winshuttle QUERY. No additional layer 

of security is required. 

Infoset/SAP Queries 

SAP query and Infoset query are the end-user query reporting tools. These are very valuable tools 

in generating customized reports. The real benefit is for the business users who otherwise will 

have to rely on programming staff to generate reports from the system. You can access SAP 

queries and Infosets which are already created in SAP, using Winshuttle QUERY. 

You can use Infosets and SAP queries only if it is enabled in Administrator options. In addition, 

only one Infoset/SAP query can be added to the query builder area at a time. Joining of more than 

one Infoset/SAP query with tables is not supported. 

Security handling 

The table containing authorization objects for fields is used to securely extract records for 

Infoset/SAP Queries. For more info, see Authorizations (on page 108). 
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Security is applied on Infoset/Query corresponding to the presence of table and field in 

authorization table. For example, if MARC-WERKS is present in Infoset/Query, it is checked in a 

single table authorization table. If it exists, the data is filtered accordingly. 

There is difference between how it is handled for Infoset query and SAP query. 

 For Infoset query: It does not depend whether you have selected a field as output or not. 

 For SAP query: Security is applied only to output fields. It is not applied to selection fields. 
 

Starting a query 

The selecting stage is the first stage in the query builder process of QUERY. You are defining your 

query. 

You have options for how you build a query, including the following: 

 Create a new query (.qsq file) and define all the search criteria. 

 Re-use saved queries. 

 Open a query template. 

To start a new query 

 On the QUERY welcome screen, click New . 

To open a query template 

 On the Select pane, click Create Query using Winshuttle Templates. 

To re-use an existing query 

 On the QUERY welcome screen, click Open . 

 
 

Tables and the Winshuttle Data Dictionary 

Depending on the data source you choose while creating a query, the building block of any 

Winshuttle QUERY could be tables, Infosets or SAP queries, or logical databases. These items are 

found within the Winshuttle Data Dictionary. 

The Winshuttle Data Dictionary 

The Winshuttle Data Dictionary contains the most frequently used SAP tables, logical databases, 

and infosets and SAP queries. 
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In the data dictionary, the tables are organized according to functional area, such as Materials 

Management, Sales and Distribution, Human Resources, and Production Planning. Tables that are 

relevant to specific transaction codes are organized under the Transaction Codes item. 

Tables appear in data dictionary in the following order: views, transparent tables, pool tables, and 

cluster tables. The tables are sorted alphabetically within each table category. When a new table 

is added to a category, it is added at the bottom of the list, but the entire list of tables is sorted 

again when the Winshuttle Data Dictionary is revisited. 

Centralized Data Dictionary 

The Winshuttle Data Dictionary can be available individually on each user's computer or as a 

single Centralized Data Dictionary that is made available to all users by the administrator. 

Synchronizing tables or the data dictionary 

If you have a local data dictionary or are a data dictionary administrator, when QUERY is first used 

and after each update to QUERY, you must synchronize the tables. 

To synchronize the data dictionary 

 In the data dictionary pane, right-click Winshuttle Data Dictionary. On the shortcut menu, 

click Synchronize. The names in the pane change from red to black when the files are 

synchronized. For tables, the icons distinguish cluster, pool, or transparent tables, and 
table views. 

 

Data dictionary before synchronization and after synchronization. 
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To synchronize an individual table, infoset, or logical database 

 In the data dictionary pane, right-click the table, infoset, or logical database. On the 

shortcut menu, click Synchronize. The names in the pane change from red to black when 
the files are synchronized. 

To automatically synchronize a table, infoset, or logical database 

 Drag a table into the Query Builder area. The table synchronizes automatically. 

Restoring the data dictionary to its original state 

You may want to restore the data dictionary to the state it was in when you first installed QUERY. 

Restoring the data dictionary has the following effects: 

 All the previously synchronized categories, tables, infosets, SAP queries, and logical 

databases are unsynchronized. 

 Newly added categories and items are removed. 

 All search results and favorites are cleared. 

To restore the data dictionary to its original state 

 Right-click in the Winshuttle Data Dictionary, and then click Restore Master Data 

Dictionary. 

 

The Restore Master Data Dictionary item on the shortcut menu. 



Adding tables and transaction codes to the Winshuttle Data Dictionary 

 

45 

 

Adding tables and transaction codes to the Winshuttle Data Dictionary 

You can add individual tables and transaction codes (tcodes) to the data dictionary for the SAP 

Data Dictionary, including custom tables. Custom tables are user defined tables that usually start 

with the letters Y or Z. 

To add a sub-category 

1. Click Winshuttle Data Dictionary or click a node, and then click Add a sub-category. 

2. Type the name of the sub-category. Click Add. 

To add tcodes to the Winshuttle Data Dictionary 

1. Right-click the tcode node, and then click Add Transaction Code. 

2. In the Transaction Code box, type the name of the code. Click Add. 

To add individual tables to the Winshuttle Data Dictionary 

1. Right-click a category or tcode node, and the click Add a table. 

2. From the list, select the category where you would like to add the table. 

3. Type the name of the table. Click Add. 

The selected tables appear in the query builder area and in the Search node. You can then move 

the table to any category you like in the Winshuttle Data Dictionary pane. NOTE: By default you 

are limited to four tables in the query builder. However, the default can be changed by the QUERY 

administrator. For more information, see Admin options. 

Selecting tables directly 

If you know a table name, you can add a table directly to the data dictionary. 

To add a table directly to the Winshuttle Data Dictionary 

 Right-click on a category in the Winshuttle data dictionary. On the shortcut menu, click Add 

table, and then type the name of the table. One of the following messages appears: 
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o If the table is present in the Data Dictionary, you are notified of where it is located. You 

can move the table to the desired category. 

o If the table is present in the current category, you are notified that the table already 

exists. 

o If the table is not in the Data Dictionary but is in the SAP data dictionary, the table is 

added to the current category. 

o If the table name does not exist, an error message appears. 

Locating a table in the Winshuttle Data Dictionary after you have added it to the query builder 

To locate a table in the Winshuttle Data Dictionary after you have added it to the query 

builder 

1. Right-click in the table. 

2. On the shortcut menu, click Locate Table in Data Dictionary. 

The table is highlighted in blue in the data dictionary. 

 

A table highlighted in the data dictionary. 

Custom categories 

To add custom categories to the data dictionary 

1. In the data dictionary pane, right-click Winshuttle Library to add a category to the data 

dictionary, or right-click an existing category to add a new category to a functional area. 

2. In the shortcut menu, click Add Category. 

3. In the Add Category dialog box, type a name for the category, and then click Add. 

The new category appears as the last item in the list. 

To rename a category 

 Right-click the category. In the shortcut menu, click Rename category. 
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To delete a category 

 Right-click the category. In the shortcut menu, click Remove category. 

Warning: If you delete a category, all the subordinate categories and tables will also be deleted. 

Favorite tables 

If you use tables frequently, you can add them to the Favorites heading in the data dictionary. 

With a Centralized Data Dictionary, you can assign favorites, which are not written to the 

database. 

To add a table to the Favorites heading 

1. In the data dictionary, right-click on the table name. 

2. On the shortcut menu, click Add to Favorites. 

To remove a table from the Favorites heading 

1. In the data dictionary, right-click on the table name. 

2. On the shortcut menu, click Remove from Favorites. 

Zooming in on tables and the query builder 

To see details in fields and table joins when multiple tables are present in the query builder, use 

the zoom feature. 

Zooming in on the query builder 

To zoom in 

 In the query builder toolbar, click Full Screen . 

To zoom out 

 In the query builder toolbar, click the  icon to toggle back to normal view. 

 

The query builder tool bar. 
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Zooming in or out of a table 

To see details about the fields in a table, such as the field length and field type, you must zoom 

in. 

To zoom in or out of a table 

1. Right-click the table. 

2. On the shortcut menu, click Zoom In on Table. 

The details for the fields for that table appear in an easy-to-read window. You can make additional 

field selections or clear field selections in this window. 

 

 

Adding SAP Queries to the Winshuttle Data Dictionary 

Unlike for Infosets and tables, no list of SAP queries is available in the data dictionary. 

To add an SAP query to the data dictionary 

 Right-click Queries and click Add Query. 

-or- 

 Select user group, and click the query you want from the list. 

Data dictionary organization for infosets and queries 

The data dictionary for infosets and queries had two main areas, the Standard area and the Global 

area. These are based on the Query Areas defined in SAP. 
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Standard query area: Infosets/queries in the standard area are client-specific, which means 

they are available only within the client in which they were created. For example, if you created a 

standard query on a production client, the query exists only on that client. 

Global query area: Infosets/queries in the global area can be used on any client. 
 

Adding items to and searching for items in query builder 

To build a query, you must first add items to the query builder area. 

Logical databases 

Logical databases are special ABAP programs that retrieve data and make it available to 

application programs. The most common use of logical databases is still to read data from 

database tables by linking them to executable ABAP programs. 

Using logical databases in QUERY 

You can use logical databases with Winshuttle QUERY only if the Winshuttle Function Module is 

installed on the SAP server you use. 

The query builder area is divided into three areas: 

 LDB structure view: The hierarchy of logical database nodes and the parent child 

relationship is shown in this view. This will assist you in selecting relevant output fields. 

Note: Fields from two nodes which are at same level in hierarchy cannot be selected. For 

example, if five fields are selected in the node DIAUFK (PM order), and you try to select 

fields from DIPLKO (Task list header), the action will fail. 

 LDB Node View: Lists the logical database node details like name, description, and table 

details. You can search for required fields using the search bar. You also have an option to 
Select/Deselect All Fields on right click of mouse. 

 Criteria pane: Similar to tables, infosets and SAP queries criteria pane is also available for 

LDBs where you can go set desired criteria. 

To add a logical database to the query builder 

 Drag and drop the logical database into the query builder. 

Logical database structure in the query builder 

There are two views to logical databases: 
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LDB structure view: The hierarchy of logical database nodes and the parent child relationship is 

shown in this view.  

Note: Fields from two nodes which are at same level in hierarchy cannot be selected. Using the 

previous image as an example, if five fields are selected in the node DIPLKO, and you select two 

fields in the node DIAUFK, an error will occur. 

LDB Node View: Includes LDB node details like name, description, and table details. Use the 

Search field to search for required fields. To select and deselect all fields, right-click in screen. 

Tables: what tables look like 

The Winshuttle Data Dictionary displays the most commonly used tables. The tables display the 

following information: 

 Functional area, such as Finance Accounting, Human Resources, Production Planning. 

 A node for transaction codes which lists the tables used in common transactions. 

 Descriptive text to make it easier to identify the table. 

 Unique icons to distinguish different table types, such as cluster, pool, and transparent 

tables, and also table views. 

To add tables to the query builder area 

 Drag and drop the selected table from the data dictionary to the query builder area. 
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The data dictionary is on the left. The main query builder area is empty on the right. 

If you cannot find the table you want by looking in the data dictionary, you can search for the 

table. In addition, if you know the field name or know the kind of information you want, you can 

search by using the field name or description. A list of tables that contain such fields is returned. 

Limits on tables that can be added 

For tables, if you try to add more tables to the query builder area than are permitted by your 

administrator, the maximum number of tables is added to the query builder area and the 

remaining number are highlighted under their node in the data dictionary or under the Search 

node. For example, if you select 10 tables, but are permitted to add only four, four appear in the 

query builder area, and the remaining six are highlighted in the data dictionary. 

Infosets/SAP queries 

You can use only one Infoset/SAP query to the query builder area at a time. Joining of more than 

one Infoset/SAP query with tables is not supported. 

After adding the Infoset/SAP query into query builder area all the underlying fields in the query 

are seen in one single table. For each of the fields even the table name is seen. Refer the figure 

below. 

For Infoset query you can chose any field as output field and they get listed in the criteria pane. 

You can now set criteria on it. For more details on usage of criteria pane please refer to the 

section - Using criteria to define fields. 

Note: You cannot deselect the default selection fields for criteria in an Infoset. These selection 

fields have been set during the creation of Infosets on your SAP server. 

For SAP query you cannot select or deselect any field for output or criteria. 

However, you can modify the criteria. You can change the specifics of the criteria. 

Note: AND expression and IN operator are not available for Infosets/Queries. 
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Searching data dictionaries for sources 

 

The Search in Winshuttle Data Dictionary dialog box, with options common to all sources 

To search for a data source 

1. At the bottom of the Winshuttle Data Dictionary, click Search in Data 

Dictionary . 

2. In the Search in Winshuttle Data Dictionary dialog box, enter a item name, field name, a 

description of the item you want, or a description of the field you want. You can use 

wildcards to narrow your search, and you can apply case sensitivity to the search. 

3. Click Search in Winshuttle Library. 

All tables that contain the string you searched for are listed. Select the items you want. The 

items appear in the query builder. 

4. To add the selected items to the data dictionary, click Add a Table to the Data Dictionary. 

The table is added to data dictionary and to the query builder. 

5. If you cannot find the item in the Winshuttle Data Dictionary, click Search in SAP Data 

Dictionary, and then try again. 

The selected items appear in the query builder area, and are also added to the Search Results 

node in the Winshuttle Data Dictionary pane if they are not already in the data dictionary. If the 

found tables are in the data dictionary, they are highlighted in the nodes that they belong to. 
 

Creating joins between tables 

Relationships between tables increase the power of queries. In QUERY, relationships, or joins, are 

created automatically when multiple tables are added to the query builder area, if a primary key 

link or a check table link exists between the tables. 

Primary key links and check table links 

A check table link exists when two tables are linked by foreign key fields. One table assigns some 

of its fields to be the primary keys of another table, called the check table. 
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A primary key join is possible when the primary keys in the tables have the same field name, and 

are of the same data type and field size. The primary is indicated by a key icon . Indexes are 

indicated by a blue inverted key . 

Default joining of Primary and Index Keys 

If a primary key and index key have matching data fields, the application creates automatic joins 

between the primary key and the index key. The tables must contain the same field name, field 

size, and be of the same data type.   

NOTE: If primary keys are linked, index keys are not joined automatically. 

User-created joins 

In QUERY, you can create and remove joins if the administrator grants permission to do so. In 

addition to creating joins on regular tables, you can join cluster and pool tables, and views. You 

can also join a table to itself. 

The administrator must grant permission for all joins. For more information, see Admin options 

(see "Administrator options"). 

NOTE: Automatic and user-created joins appear only on SAP systems where the function module 

is installed. For all other setups, only single-table downloads are possible. 

To create a join between two tables 

 Drag a field from one table and drop it into the other. 

All downloads from joined tables are by an inner join--all matching records are downloaded. 

Important: If you use multiple tables, they must be joined. If the tables that you query are not 

joined, the query will not run. 

To join a table to itself 

1. Double-click the table twice to add the table and its alias to query builder area. For 

example, if the table is MARA, its alias will have the name MARA1. 

2. To create the join, drag a field from the table or alias and drop it onto the alias or table. 

All downloads from joined tables are by an inner join--all matching records are downloaded. 

Left Outer Joins 

You can create left outer joins in the QUERY builder. This would allow data to be returned from 

one table even there are no matching records in the second table. Note that outer joins can 

degrade performance. 

Recognizing left outer joins 

You can recognize a left outer join in QUERY by the join line with an arrow pointing to the left 

table.  
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In case two tables are added with left outer joins, the joining arrow may not appear accurately. 

However, this does not affect the function of the joins.  

 

To convert to left outer joins 

1. In QUERY builder, right-click on the joining link between the tables.  

2. In the shortcut menu, click Convert to left outer Join. 

A warning messages displays stating that converting to left outer join may degrade the 

performance. 

To remove or convert an outer join 

1. Right-click the left join. 

2. On the shortcut menu, click Remove or click Convert to outer join. 

Conditions for creating left outer joins 

 Maximum of 25 tables can be joined that can include inner and left outer joins. 

 Only two tables can have left outer join between them in a query. 

 The table on right of a left outer join cannot be a right table of any other join. 

 For left outer join between two tables, no other type of join is allowed across any of their 

fields. 

 Any field in the right table that has a left outer join cannot be used as selection. 

 Any query with a left outer join altered in previous version of QUERY may not generate 

accurate results. 



Logical Databases 

 

55 

 

 The following conditions are applicable for "Possible Joins" when a left join exists: 

o All entries conform to left join conditions. 

o Selecting some joins in the grid may disable other joins because of left outer join 

limitations. 

o Running a query with a left outer join on a version of the Winshuttle Function Module 

with a version earlier than 10.2 displays an information message to abort the run. 

To delete a join 

 Right-click the join line that you want to delete, and then click Remove. 

Joining with infosets and SAP queries 

You can use only one Infoset/SAP query on query builder area at a time. Joining of more than one 

Infoset/SAP query with tables is not supported. 
 

Selecting fields 

Selecting the specific fields that can provide answers to your questions reduces response time and 

unnecessary records. 

Fields represent specific data elements in databases. 

Infosets and SAP Queries 

After adding the Infoset/SAP query into query builder area all the underlying fields in the query 

are seen in one single table. For each of the fields even the table name is seen. 

For Infoset query you can chose any field as output field and they get listed in the criteria pane. 

You can now set criteria on it. For more details on using the criteria pane, see "Using criteria to 

define fields". 

Note: You cannot deselect the default selection fields for criteria in an Infoset. These selection 

fields have been set during the creation of Infosets on your SAP server. 

For SAP queries, you cannot select or deselect any output or criteria fields. 

However, you can modify the criteria. For example, you can change the selection type to Fixed 

from Runtime, change the Where Clause details, or make the criteria mandatory. 

Note: AND expression and IN operator are not available for Infosets and SAP queries. 

 Click Preview run to test the designed query. 

 Click Number of entries to know how many records are extracted. 
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Logical Databases 

Once the logical database is added to query builder area, select the output fields. The selected 

output fields appear in the criteria pane. 

Selection fields are the fields on which the criteria is set. You cannot deselect any of the existing 

selection fields or add new selection fields. You can use only what is already set inside the logical 

database you want to use. 

However, you can modify the criteria. For example, you can change the selection type to Fixed 

from Run time, change the Where Clause details, and make the criteria mandatory. 

Note: 

AND expression is not available for logical databases on Where clause builder. 

In the WHERE clause builder, only those logical operators are available that are applicable to the 

selected field. For example, if there is a field on the selection screen of an logical database which 

requires a range of values (such as, FROM and TO) as input, the BETWEEN operator will be 

available for this field in QUERY. 

 Click Preview run to test the designed query. 

 Click Number of entries to know how many records are extracted. 

Note: The following items are not supported in the current version of QUERY. 

 Radio buttons, list boxes, buttons on selection screen 

 Logical databases with Dynamic node 

 Any logical databse which has any additional screen, such as a pop up, which comes after 

the selection screen 

 LDBs Node Types are not supported: 

 C - Complex data object 

 A – Typed nodes (ANY) at runtime (such as PNP, PNPCE) 

Tables 

A table can contain from a few fields to hundreds. By default, primary key fields and index fields 

are listed at the top according to name and description. Fields that are primary keys are 

represented by a key icon and index fields are represented by an inverted key icon . 

QUERY also offers other means for you to easily find fields in a table. 
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To find fields in a specific table 

 Right-click the table, and then select one of the following sort or search options on the 

shortcut menu. 

o Sort by name. Sort by ascending or descending order. 

o Sort by description. Sort by ascending or descending order. 

o Default sorting. By field name, but with primary keys at the top. 

o Sort by selection. This option displays your selections at the top of the tables and is 

useful when you want to create joins between two tables that contain many fields. 

o Zoom In on Table. The Fields Selection windows shows field names and descriptions. 

You can search for fields by using a whole name or use the Begin with setting to search 

by using the first letters of a name. 

o Begins with. Select when you are sorting on search fields to search first on field 

description and then on field name. 

 

A table after you zoom in. With the Begins with setting selected, the letter v was entered as the 

search field. It returned two fields whose names and description begin with a "v". 

To select fields for output 

 Select the check box next to the field you want to add. 

 

A selected fields in the G/L Account Master table. 

To select all fields 

 Right-click the table, and then click Select all fields on the shortcut menu. 
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To deselect all selected fields 

 Right-click the table, and then click Deselect all selected fields on the shortcut menu. 

Using criteria to define fields 

 In the Criteria form, you specify how the fields you have chosen are processed in the 

query. You also specify criteria that further define the query on the selected fields. 

Fields in the criteria pane 

Column name Details 

Output  

Select this if you want the field to be displayed in the 

result set. If you clear the check box, you can still use it 

to build a Where clause and use it to filter data. 

Selection Select this if you want to set criteria on a field. 

Field description 
Shows the SAP field description. You can edit it and 

enter your own custom description. 

Technical name 
The expression table name. Field name is displayed 

here. 

Selection type 
Using this option you can choose either to predefine the 

criteria or set it during run time. 

Where clause Click the ellipses  to launch the Where clause builder 

and set the criteria. 

Required 
Select this option to make it mandatory to enter criteria 

during run time. 

Lookup type 

Select the source for the lookup values. 

SAP Optional. Either look for values in SAP or manually 

enter any value. 

SAP only. Select the values from the list SAP provides. 

List. Select values from the customized list created by 

the query designer. 

Padding 

Controls automatic padding for numeric values of string 

fields.  

Padding is applied automatically, for Num, Char, 

Numchar, and string values, but you can select to 

remove it. Padding improves the accuracy of your data 

extracts and is important for extracting the correct 



Using criteria to define fields 

 

59 

 

values from SAP. 

Note: If you compare non-numeric data without 

padding, QUERY may return unexpected results. 

SAP type The data type of the field in SAP table. 

To add criteria for a field 

1. Click Selection for a field on which you want to set the criteria. 

2. The default values for the other columns will appear as explained below 

Column name Default value 

Selection type Runtime 

Required None 

Lookup type SAP optional 

3. You can change these default values as per your requirements. 

If you chose the Selection type as fixed, the Where clause builder launches as seen in the figure 

below 

 

4. If you want to make criteria on any field as mandatory, click Required. 

5. Set the lookup type. 

6. Click Show Preview to see sample run of the designed query. 
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To clear criteria 

 Click the criteria that you want to remove, right-click, and then click Clear Criteria. 

 

To sort criteria 

 You can sort criteria on the following columns in the criteria pane: Output, Selection, Field 

Description, and Technical Names. 

The power of WHERE clauses 

Use WHERE clauses to limit extractions and thus reduce download time. Where clauses are 

especially useful in multi-table queries. If no WHERE clause is specified, all records will be 

returned. 

With the WHERE clause builder, only those logical operators are available that apply to the 

selected field. In addition, you can use AND and OR operators between clauses. You can build as 

many WHERE clauses as you need. 

 

The WHERE Clause builder 
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Fields in the WHERE clause builder 

Field name Automatically generated, this indicates the table name and the 

selected field name. 

Field type QUERY displays the type of field, whether a string, double-byte, 

date or time data type. 

Field size QUERY displays the size of the selected field in bytes. 

Padding Controls automatic padding for numeric values of the string 

fields. Note: If you compare non-numeric data without padding, 

QUERY may return unexpected results. 

NOT operator Specify whether you want the inverse (NOT) of the specified 

operator. 

Operator The available operators change according the field that is 

selected. Operators include =, <, >, <=, >=, <>, Like, Between, 

In, Is Null, Is not Null 

Condition Type a condition to define the search, or press F4 to see a list of 

SAP values that are allowed for that field. 

OR and And 

expression 

Use AND or OR to apply more than one condition. 

To specify conditions in a WHERE clause 

1. Specify an operator or the NOT operator. 

2. Do one of the following: 

o Specify a condition. 

o Click inside the Condition box, and then click Select SAP values (F4) to choose a value 

from SAP. 

o Add the list of condition values to a text or Excel file and use Select file constants to 

indicate the file path. 

o Use the Enter values option to enter multiple condition values. 

3. To apply another condition, click OR or AND, and then repeat steps 1 and 2. 

The Like operator and wildcards 

The like operator has unique behavior in QUERY. You can apply wildcards to fine-tune your query. 
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Single underscore or question mark 

a_ or a? returns records for values like a1, a2, and ab, but not a12 or abcd. You can use any 

number of underscores the number of characters you want to match. 

Percentage 

a% or a* returns all values that start with ‘a’, followed by any number of characters. For example, 

it matches a1, a2, ab, a12, and abcd. 

Select Date Constants/Values 

With the Select Constant/Variables option, perform date math, such as Today-120. You can also 

select the date from the calendar displayed or chose an SAP initialized date. Date values for 

criteria must always be specified in the correct date format as selected in Tools > Options > SAP 

Defaults. 

 

The Enter Values of Run Time Variables dialog box, which appears when you select constants and 

variables. 

Select SAP Values (F4) 

To add SAP values to the criteria builder 

1. To add values appropriate to a field in your criteria builder, click Select SAP Values or press 

F4. 

2. Click a value, and then click the Check Mark. The value appears in the Condition box. 
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The SAP values that appear when the SAP GUI is available. 

 If the SAP GUI is not installed on your computer, or if the field selected in the table has no 

associated description in SAP, only the values (without their description) are displayed. By 

default, the first 100 records are scanned and relevant values are displayed. To see more 

records, specify the number you want to scan in the No. of Records box. Maximum number 
of values that can be scanned are 5000. 

 

The SAP values dialog box, which appears when you click the SAP Values button. 

Adding run time values 

When you include run time variables as criteria values, the values must be added at run time. If 

the criteria was set as "Required", it is mandatory to add values at run time. 

If you use the IN operator in the criteria you can select either a text or an Excel file to contain a 

list of values that are read in when the query is previewed or run. 
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The dialog boxes for the Select File option. 

Number of entries 

This feature is available for single table and multiple table queries. Click Number of Entries  to 

see the number of records that the selected criteria will return. 

Show Preview 

 Click the Show Preview button  to see the kind of records that the query you have built 
will return. By default, 100 records are returned. 

 

The Preview Run dialog box which displays an example of the kinds of records that will be 

returned by your query. 
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Show query 

 Click the Show query button to see the SQL expression that is created by the query. 
 

Saving a query 

When you have finished creating your query, QUERY prompts you to save the query. 

You can also save a query from the File menu. 
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Best practices for query names 

A good practice for naming query files is to follow this convention: functional area, tables, and 

date. For example, for an asset master, a query file name would look like this: 

asset_master_ANLA_111208 

 

 



 

 

Mapping 

In the mapping stage of the query process, you map the fields of your query to the columns of 

your output file. Each column header corresponds to a field. QUERY provides easy drag-and-drop 

editing of fields. Output options in QUERY include Microsoft Excel, Microsoft Access, and Microsoft 

SQL Server files. 

You can map the fields of any data source available to QUERY. 

 

The map pane before a query file is mapped. Click Create Mapping to map manually or click Auto 

Mapping to automatically map all the query fields. 

In the mapping stage of the query process, you map the fields of your query to the columns of 

your output file. Each column header corresponds to a field. RUNNER provides easy drag-and-drop 

editing of fields for queries that are already mapped. 

To change query mapping 

 In the Mapping pane, click Update query mapping. 

Mapping fields manually 

To map fields manually 

1. From the Map pane, click Create mapping. The Mapping screen appears, including the 

query field form and the empty preview of the results file. 

2. Drag fields down from the form to the file preview area in the order you want. 

3. From the Map pane, click Update mapping. The Mapping screen appears, including the 

query field form and the preview of the results file. 

4. Drag fields down from the form to the file preview area in the order you want. 
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Auto map query fields to a data file 

To map fields to an existing or new data file from the map pane (Excel or Access) 

1. From the Map pane, click Auto Mapping. 

2. The Auto Map File dialog box appears. 

3. Specify the type of destination file for the data, whether Access or Excel. 

4. Do one of the following: 

o To create a new file, specify the path and name of the file. 

-or- 

o To map the data to an existing file, click the folder icon  to locate the file. Click OK. 

You can use Auto Mapping to automatically map all data fields in the query file to Excel worksheet 

columns or Access database fields. 

To auto map query fields in the mapper  (Excel, Access or SQL database) 

 In the mapper, click AutoMap. 

The fields are automatically arranged in the result preview form. 

 

The AutoMap button as it appears in the Mapping pane. 

The result file preview 

The result file preview consists of columns or rows into which you drag fields. With this form, you 

can see how your output file will look. 

To change the type of output file 

 Click Change Destination Type . Click Excel, Access, or Microsoft SQL 
Server. 

The query field form 

S. No Row ID or sequence of fields for output 

SAP field name 
SAP name, usually a German acronym or 

abbreviation 
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Expression The table name and field name 

SAP Field Description A description in English of the contents of the field 

Field Type Byte, decimal, integer, string, date or time 

Field Size Number of characters in the field contents 

Padding 

Controls automatic padding for numeric values of 

the string fields. Note: If you compare non-numeric 

data without padding, QUERY may return 

unexpected results.  

Mapped to Column 

The letter of the output column to which a field is 

mapped. Available for Microsoft Excel and Microsoft 

Access 

Fields that apply only to Excel 

Excel Expression 
The excel formula you want to apply on 

corresponding field 

Expression evaluation cell 
The cell which will be used for interim calculations of 

excel formula 

Transform original 

mapping 

Option to overwrite the original data with 

transformed data 

Expression evaluation 

description 
Relevant header description for the evaluation cell 

Mapping headers 

To map fields to Excel column headers 

 Drag each selected field and drop it under a column header in the output file. 

To map fields to Access tables 

1. Drag each selected field and drop it under a column header in the output file. 

2. Click Add Log Column (optional)   to add a column into which the SAP 

log data can be written. 

To modify fields in an Access table 

 To change the name of a field, right-click the field, and then click Rename. 

 To change the name of the table, right-click the Table tab  .. 
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Transforming data before the download 

By using Excel formulae during mapping stage, you can transform data before downloading it. 

This feature is available only when the destination type is Excel. 

1. Click Update Mapping on the Mapping pane. 

2. For the field whose output you want to transform, find the Excel Expression column, and 

then enter the Excel formula. In the example below, a formula is entered for the field 

GROSS WEIGHT. This formula will be applied to GROSS weight values that start from cell 

G2 and resultant value will be stored in column H from cell H2 onwards till the last record 

extracted. The cell H2 is mentioned in the expression Evaluation Cell (refer to step 4 

below) 

 

3. Enter the appropriate Excel cell value in the Expression Evaluation cell. This cell will be 

used to evaluate the excel expression and place the transformed data. It is mandatory to 

enter this information. In the example mentioned in step 2, the transformed data will be 

written into the column H starting from cell H2. 

4. To validate the Excel formula, click Validate . Note that the validate option is 

supported only for formulae that are entered in English. 

5. To choose to overwrite the original data with transformed data, select Transform Original 

Mapping. In the example below, the formula is applied to MATERIAL NUMBER and the 

transformed value is written back in column A. In this example, column I is used only for 

interim calculations and will be deleted after the calculations are finished. 
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You may also choose to give relevant header description for the evaluation cell in the column - 

Expression Evaluation Description. This information is not mandatory. 

After you save the changes and run the query, you can extract the transformed data. 

To open an existing result file 

1. Click Open , and then select the Access or Excel file you want. 

2. Mapping to an existing file does not change the headers in the file. 

3. To add headers to an existing result file, ensure that Write header information on result file 

is selected on the Advanced Run Options pane. For more information, see Advanced Run 

Options. 

To save a file 

 Click Save  to save the mapping instructions to an Excel or Access file. Or, browse 
to an existing file to save the new mapping instructions. 

Winshuttle SERVER for QUERY 

With the Winshuttle SERVER for QUERY (formerly known as sqlSHUTTLE), you can send extracted 

data to a SQL Server database. You create a SQL Server table just as you would create an Access 

table. The only difference is that when you save the table, you connect to the server and select a 

database. Your new table is then created in the database. Winshuttle SERVER must first be 

connected to SQL servers. For more information, see Winshuttle SERVER Configuration. 

To map fields to a SQL Server table 

1. Drag each selected field and drop it under a column header in the output file. The changes 

can be seen in the field form. 
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2. Drag each selected field and drop it under a column header in the output file. The changes 

can be seen in the field form. 

3. If you want, click Add Log Column  to add a column into which the SAP 

log data can be written. 

To modify fields in an new SQL Server table 

1. To change the name of a field, right-click the field, and then click Rename. 

2. To change the name of the table, right-click the Table tab . 

NOTE: You cannot rename a table or change fields in an existing SQL Server table. You can only 

add fields or a log column. 

To open an existing database table 

1. Click Open . The Connect to Server dialog box appears. 

 

2. Type in the name of the server you want to connect to or select a server from the list. 

3. Select the type of authentication to use, whether SQL Server Authentication or Windows 

Authentication. 

4. Do one of the following: 
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o For SQL Server Authentication, type your SQL Server user name and password. 

o For Windows Authentication, your user name and password are automatically captured. 

o Click Test Connection to verify that your user name is authorized. 

o Select the database and table. Click Connect. 

To save a file to SQL Server table 

1. Click Save  to save the mapping instructions. The Connect to Server dialog box 

appears. 

 

2. Type in the name of the server you want to connect to. 

3. Select the type of authentication to use, whether SQL Server Authentication or Windows 

Authentication. 

4. For SQL Server Authentication, type your SQL Server user name and password. Your 

details are automatically filled in case of Windows Authorization. 

5. Click Test Connection to verify that your user name is authorized. 

6. Select a database where information will be stored. Click Connect. The data movement 

happens only within the database so you do not see the file open. However, the status bar 

displays a message to show the file name, the server on which it was created, and the 

database in which it was stored.  

Undo mapping 

After selecting a particular destination type user can undo any step performed in mapping. The 

number of levels of undo is unlimited. 
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To undo mapping 

 Press CTRL + Z. 
 

Embedding a query file in an Excel worksheet 

From the Run pane, you can embed the active query file in an Excel file or template. Then you can 

send the Excel worksheet that contains the query file to business users. 

To embed a query file in an Excel spreadsheet 

1. Click Publish query file  to embed the query file in an Excel file or template. The Publish 

query File dialog box appears. 

2. Type the file name you want to save the file under. The file extension is .xls for a file or 

.xltx for an Excel template. 

3. On the Export to Template dialog box, type the file path to the Excel you want to use. You 

can also click the folder icon on the right to browse to the query files folder. Enter a short 

description of the purpose or use of the file. The current query file is exported to the 

template you select. 
 

Using the add-in for Excel 

QUERY provides an add-in for Excel called the QUERY add-in. You can use the QUERY add-in to 

run existing queries or update the mapping of existing queries, but not to edit or create them. A 

query can be run from Excel if it is published to any Excel file or template from QUERY client. If 

TRANSACTION is also installed on your computer along with QUERY, you can use the QUERY add-

in to query the data, edit it, and upload data back to SAP using TRANSACTION. 

When QUERY is installed, the QUERY add-in is automatically installed in Excel. 

To view the QUERY add-in in Microsoft Office Excel 2007 

  Click the Winshuttle tab , and then click the QUERY add-in. 

To view the QUERY add-in in Microsoft Excel 2003 

  Click the QUERY add-in. 

QUERY add-in settings 

The default values for run settings are the same as in the query file. However, at run time they 

can be changed. 
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Select query file 

Available only if no published file exists in the Excel file. Click Browse and select the query file to 

open. The file details appear automatically. You cannot type in the file path. 

Published query files 

Lists all queries that are published in the Excel file. Select a file to see its details. 

Start Row 

A required setting. If no value is entered, the start row is 2. The setting is not saved after run 

time in the Excel sheet or in the published query file. 

Log Column or Cell 

Type the Excel column where the log message has to be returned. If left blank, the log message is 

written to the first cell of the last column 

Extract all records 

Select this option if all records are to be extracted 

No. of records to extract 

Enter the required number of records to be extracted. This gets disabled if Extract all records 

option is selected. This is a required field. If you do not specify a value, the value is set to 

1000000. 

Write Header 

Adds or removes the column header to the output file. 

Run reason 

Enter a reason for the run. This is a run time setting and is not saved in the Excel sheet or in the 

published query file. 

Run 

Click Run to execute the query and download the records. 

Number of Entries 

Click on this to get the number of records that will be extracted using this query. 

Status bar 

This bar provides the logon information. It can also be used to log off from the currently logged in 

system.  
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Running queries from the QUERY add-in for Excel 

To run a query in Excel 

1. Select the query file or published file you want to run. 

2. Enter the details in the run settings. 

3. Click Run  to execute the query. The records are downloaded to the Excel sheet. 

In Excel 2007, each cell can accommodate 8192 characters and in Excel 2003 each cell can 

accommodate 1024 characters. If a long text field that was used in the query contains characters 

that exceed these limits, the field must be trimmed to ensure a successful download. 

Using the QUERY add-in for Excel with TRANSACTION 

You can use QUERY add-in and TRANSACTION add-in together in Excel. 

To download data, edit it, and upload query results from an Excel sheet 

1. Select the published query file you want to run. 

2. Enter the details in the run settings. 

3. Click Run  to execute the query. The records are downloaded to the Excel sheet. 

4. Make the necessary modifications in the downloaded records. 

5. To open QUERY, click QUERY add-in in Excel 2007 or in Excel 2003. 

6. Select an existing .TxR file that was created in the same file or template. Edit the run 

settings. 

7. Click Run  to run the .TxR file. The changes are uploaded to SAP. 

 

 



 

 

Running the query 

Running 

With QUERY, you can run a query manually or you can perform unattended data downloads by 

scheduling runs for off-peak hours to reduce system resource load. For unattended data 

downloads, if you provide an e-mail address, QUERY can send e-mail notification or an attached 

copy of the results file when the run finishes. 

Before you run a large query. It is recommended that you first do a test run with a few hundred 

records. Once you are satisfied with the test run, you can proceed with your query. 

 

The Run pane with an Excel file open. 

The Run pane contains the following options: 

Select Result file or 

database 

Specify a result file or database. The default is the file or database that 

you saved during the mapping step. 

Sheet, Table 

(Excel, Access, and SQL 

databases only) 

The sheet or table to which the data is sent. The default is the sheet or 

table that you specified during the mapping step. However, you can 

specify another sheet or table. 

Reconnect and Refresh (SQL 

database tables only)  

Click Reconnect and Refresh to display a list of all tables in the system. 

You can then change the table to which data will be downloaded. 

Record delimiter (text files 

only) 

The character used to separate the values of each row of data. Select 

from |, ;, #, $, &, @, %, ,, _, *, ', and TAB. 

Header delimiter (text files The character used to separate the values in each header row. Select 
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only) from |, ;, #, $, &, @, %, ,, _, *, ', and TAB. 

Start row 
Specify the row wherein you want QUERY to begin adding records. 

(Available only for Excel files.) 

Log Column/Cell (Excel 

files) and Log Column 

(Access and SQL files) 

Specify the column and cell or column in which SAP log information is 

written. This information appears automatically. 

 

Extract all records check 

box 

Select this check box if you do not know how many records are 

available for the download. Selecting this check box has the same 

effect as if No. of records to extract is set to '0'. Must be enabled by 

the administrator. 

No. of records to extract Specify how many records should be extracted. If '0' is specified, 

QUERY returns all records (if allowed by the administrator) or the 

maximum number of records that you can download. 

The default is 1 million records, which is set by the administrator. If 

you specify a number that exceeds the maximum limit, the query will 

not run. 

The Extract all records setting overrides this setting. 

Run reason Add a comment about why the query was run. 

Run options Select Run now or Run later to specify an unattended run. 

To run a query 

 In the Run pane, click Run. 

For Excel files, the file opens and the results are displayed. 

In Excel 2007, each cell can accommodate 8192 characters and in Excel 2003 each cell can 

accommodate 1024 characters. If a long text field that was used in the query contains characters 

that exceed these limits, the field must be trimmed to ensure a successful download. 

Adding run time values 

If you have included variables as criteria values, at run time you need to add other values or add 

the name of the file that contains the values. 

 If you have included variables run time variables as criteria values, at run time you need to 

add other values or add the name of the file that contains the values input them. 

 If values were set as "Required" when the criteria were set, it is mandatory to provide 

inputs. 

 If you used the IN operator, you can select an Excel or a text file. 
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The Criteria Values File dialog box with the Text File option selected. 

 

For an Excel file, specify the following required settings: 

 Sheet Name 

 Column Name 

 Start Row 

 End Row 

For a text file, you need only specify the path for the file that contains the values. 

Scheduling a run 

With QUERY, you can schedule unattended queries. 

To schedule a run 

 Under Run options, click Run later, and then click Run. You are prompted to save the 

query. 

The Schedule Run wizard appears. Follow the steps to schedule a query run. 

To complete the Schedule Run Wizard 

1. Do one of the following: 

o Click Capture SAP details to automatically retrieve the information that is selected on 

the SAP Logon dialog box. Clicking Capture is the easiest and most error-free method 

for adding logon details to the scheduler. 

-or- 

o Type in the required information in the fields. 
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SAP System Name Specify the SAP system name 

Application Server Host Enter the host name. 

System number Specify the system number. 

Use Logon Group 
Select this check box to update logon 

group information. 

Logon Group If available, type the auto logon group 

information. 

Message Server Host If available, type the message server host 

information. 

Use SSO1 

Select this check box to enable single sign 

on. With single sign on, the SAP system 

uses the Windows credentials (user name 

and password) for each user.  

Partner Specify this connection parameter if you 

select single sign on. 

Client Enter the client number. 

User name Specify the user name. 

Password Specify the SAP password for the user. 

Language 
Specify the language that the system 

should use. 

EP URL 
If available, specify the enterprise portal 

URL. 

E-mail notification 

Type the e-mail address for the person 

who you want to receive notification by e-

mail message when the scheduled run is 

completed. You can specify multiple e-mail 

addresses that are separated by 

semicolon. 

Attach data file to the mail 
Select to attach the results file to the e-

mail message. 

Run on console 
If the query is to be run from the 

command line, select Run on console. 

2. Click Test to confirm that your logon information works. Click Next. 

3. On page 2, for Excel, text, and XML files and for Access tables, select one: 

Perform this task: 

Once: Schedules a one-time run. If you select 

Once, you can set the Run on date. 

Daily: Schedules a daily run. 

Weekly: Schedules a weekly run. If you select 

Schedule Weekly, enter the weekly frequency. 

You can also specify the day of the week for 

the run. (The Weekly setting is not available for 
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SQL Server.) 

Monthly: Schedules a monthly run. If you 

select Schedule Monthly, enter either the date 

each month for the run or the ordinal date. You 

also mark the months for the run. 

Run as 
If you want the task to run even if you are not 

logged on, enter your Windows user name. 

Start Time 
Select the time of day when the scheduled task 

is to take place. 

Password 
Enter the password the user provides to log 

onto Windows. 

Run only if logged on 
When selected, the user must be logged on for 

the scheduled task to be completed. 

-or- 

 If you are running a SQL Server table, specify your authentication selection: 

o Authentication: Select SQL Server Authentication or Windows Authentication 

o Windows Username: If you selected Windows Authentication, your Windows username 

and password should be applied automatically. 

o SQL Server Username: If you selected SQL server authentication, type your SQL Server 

username and password. 

o Winshuttle SERVER for QUERY Address: Add the IP address:Port for the server you 

want to run the query on. 

o To complete the scheduler settings, click Next to go to page 3. See the instructions for 

Excel files to complete the scheduling options. 

  

The Scheduler pane 

In the Scheduler pane you can manage all your scheduled queries. View the query name, the 

name of the output (data) file, the time when the run is scheduled, the last date and time when 

the query was run, the next time the query is scheduled to run, and the e-mail address of the 

person who will receive notification that the query has run. You can also set the schedule for 

queries. 
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To open the Scheduler pane 

 On the Tools tab , click Scheduler . 

To edit a schedule 

 Click Edit  to open the Schedule Run Wizard to edit options. 

To remove a query from the schedule queue 

 Click Delete . 

To schedule a run from the Scheduler pane 

 Click Schedule a run . The Schedule Run Wizard opens. 

Stopping a query run 

You can stop a running query by clicking the Stop button . The stop functionality is 

useful if you inadvertently begin a large run or if a runaway process is impacting database 

performance. 

Note: You can stop a running query, only if it has been created with tables as the data source. 

You cannot stop a query run that contains InfoSets, SAP queries, or logical databases.  
 

Using saved queries 

You can use saved queries by going to the Query Manager. For more information, see Managing 

query files. 
 

Running QUERY from the command line 

QUERY can be used from command prompt in two ways. 

 Run QUERY so that programs screens appear. Use querySHUTTLE.exe. 

 Run QUERY as a console application so that program screens do not appear. Use 

querySHUTTLEcom.exe 

NOTE: You must enclose the name of the QUERY executable and the full path in double quotation 

marks. In addition, ensure that there is a single space between the QUERY executable path and 

the query file path. 
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For Open (program screens appear) 

"C:\Program Files\Winshuttle\RUNNER for QUERY\xSHUTTLE.exe"  

-opn" C:\ Test\Testquery.qsq" 

-rfn"C:\ Test\Testquery.xls" -rdt"Sheet1" -nrc"1000" 

-srw"10" -alf" C\Test\Testquery.alf" 

For Run (program screens appear) 

"C:\Program Files\Winshuttle\RUNNER for QUERY\xSHUTTLE.exe" 

-run"C:\ Test\Testquery.qsq" 

-rfn"C:\ Test\Testquery.xls" -rdt"Sheet1" -nrc"1000" -srw"10" -alf" 

C\Test\Testquery.alf" 

 

As a console application 

"C:\Program Files\Winshuttle\RUNNER for QUERY \xSHUTTLEcom.exe" 

-run"C:\ Test\Testquery.qsq" 

-rfn"C:\ Test\Testquery.xls" -rdt"Sheet1" -nrc"1000" -srw"10" -alf" 

C\Test\Testquery.alf" 

 

QUERY commands 

All commands that run at the command prompt take precedence over the same commands that 

are already contained in the query file. QUERY overwrites the existing query file commands in 

memory with the commands passed from the command line. 

NOTE: It is recommended that you first test these commands in a non-production system with a 

limited number of transactions before deploying the query script. 

 

Token Description Example 

-opn Open 

-opn"C:\ Test\Testquery.qsq" 

This token can only be used with 

queryShuttle.exe 

-run Run -run"C:\ Test\Testquery.qsq" 

-rfn ResultFileName -rfn"C:\ Test\Testquery.xls" 

-rdt 

Result destination for 

Excel sheet name; table 

name for Access and 

SQL Server. 

-rdt"Sheet1" 

-srw 
Start row - in case of 

excel only 
-srw"10" 

-rtv Run-time variables 
-rtv"Tablename.Fieldname#variablename#'variabl

evalue'" 
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-eml E-mail Addresses -eml"1@test.com, 2@test.com" 

-arf 
Attaching result file with 

mail 
-arf 

-nrc 
Number of records to be 

extracted 
-nrc"1000" 

-alf 
ALF File Path/Connection 

String 
-alf"C:\Test\TestALF.alf" 

-slf 

Specify SQL logon file 

(slf) in case query 

mapped to SQL result 

destination. 

-slf"c:\ Test\Testquery.slf" 

-spw 

For suppressing 

production server 

warning 

-spw 

-log Log column 

-log"F" 

Not applicable for XML and TEXT destinations. 

For Open (program screen appears) 

"C:\Program Files\Winshuttle\query\querySHUTTLE.exe" -opn"C:\ Test\Testquery.qsq" -

rfn"C:\ Test\Testquery.xls" -rdt"Sheet1" -nrc"1000" -srw"10" -alf" 

C\Test\Testquery.alf" 

For Run (program screen appears) 

"C:\Program Files\Winshuttle\query\ querySHUTTLE.exe " -run"C:\ Test\Testquery.qsq" 

-rfn"C:\ Test\Testquery.xls" -rdt"Sheet1" -nrc"1000" -srw"10" -alf" 

C\Test\Testquery.alf" 

For Run (As a console application) 

"C:\Program Files\Winshuttle\query\querySHUTTLEcom.exe" -run"C:\ 

Test\Testquery.qsq" -rfn"C:\ Test\Testquery.xls" -rdt"Sheet1" -nrc"1000" -srw"10" -

alf" C\Test\Testquery.alf" 

For SQL Result Destination   

In case of SQL destination, the SQL Logon details need to specified in the form of a SQL Logon 

File i.e. SLF , which can be Saved by entering correct SQL Logon details (Windows / SQL 

authentication) when saving a table to SQL server.  
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-slf "c:\ Test\Testquery.slf" 

For Attaching Result File in e-mail message (Not for SQL Result Destination) 

-arf 

For Suppressing Production Server Warning 

-spw 

Run-time variables 

If you added run-time variables to your query, you can call them when you run the query from 

the command prompt. Variables take the following form: 

-rtv"TableName.FieldName#Value1#Value2|Value3#Value4|Value5|Value6" 

# The hash symbol is used for separation between run-time variables values.   Values should be 

in same sequence as they are defined in Query Where Clause Builder screen. 

~ The Tilde symbol is used for separation between run-time variables. 

| The upbar/pipe symbol is used to separate variable values in which between and in are used. 

Parameter Format is as follows: 

"TableName.FieldName#Value1#Value2|Value3#Value4|Value5|Value6~TableName.FieldName#

Value1#Value2" 

(For example, the first field name has four run-time variables in which between and in variable 

values are separated by the upbar |. The hash symbol # is used for separation between run-time 

variables value.)  

Here is the example of file variables. 

For txt file: 

"TableName.FieldName#Value1#Value2|Value3#c:\testvalue.txt~TableName.FieldName#Valu

e1#Value2" 

For Excel file:  

"TableName.FieldName#Value1#Value2|Value3#c:\testvalue.xlsx*Sheet name*Column 

name*Start row*End Row~TableName.FieldName#Value1#Value2" 

Note: 

If End Row will be given as 0 then the last value considered will be one having 5 empty rows after 

it. 

Tilde (~) example: 

If more than one run-time fields are present in the query, they should be separated by a "~".  

"TableName.FieldName#Value1#Value2|Value3#Value4|Value5|Value6~TableName.FieldName#

Value1#Value2" 

Note: 

 If variable is applied for a DATE field type then the value must be given in YYYYMMDD 

format. 

 If variable is applied for a TIME field type then the value must be given in HHMMSS format. 
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 If variable is applied to the Numeric field type (such as Int16, Int32, Itn64, Double, 

Decimal, or Byte) then the Value must be the raw data, i.e it should not be formatted data 

according to regional settings of your machine.(e.g. raw data is 1234567.89 number 
format available under SAP Defaults in Options). For more information, see SAP Defaults. 

 If variable is applied for String field type then no format is required. 

 The variable value for run-time file variables, that is, the path of the file must not contain 

‘#’ and ‘~’. 

 If the variable is added on an optional field (not mandatory) then user may skip the 

variable value at run time. Leaving the value as BLANK or not specifying the field name at 
all at run time fetches ALL records for the field. 

 If the variable is added on a Mandatory field (marked as required during query creation), 

then user is not allowed to Skip the value at run time. Leaving the value as Blank OR not 
specifying the field at run time stops the user from running the query. 

 
 



 

 

Recording transaction codes 

You can now record the Transaction Codes in QUERY to capture Tables and the fields that are 

being modified. 

The recording captures the Tables and the fields that are being modified, and a new category 

appears in the Winshuttle Data Dictionary called Recorded Transaction Codes.  

 

At least one recording should be performed to display the category. 

The fields that are changed during the recording are automatically selected as Output fields when 

you add those tables in the Query Builder. 

The recording of transaction codes will assist in identifying the tables as well as the fields to be 

used for building the query scripts. 

To use recorded transaction codes 

1. On the Select panel, click Create Query Using SAP Recording. 

2. Enter SAP credentials to log on to an SAP server. 

3. In the QUERY Script Properties dialog box, enter the t-code you want to use and specify 

other settings. Click OK. 
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In addition, you can add any table from the Recorded Transaction Codes category. 

 
 



 

 

Advanced run options 

On the Run pane, click the horizontal Advanced Run Options bar on the right to use advanced 

settings.  

Close application after running: Select this option to close QUERY after a query runs. This 

option is a good choice for unattended runs. 

Auto logon file: Select the auto logon file (ALF) you would like to use. For more information, see 

Automating your logon. 

Data chunk value: This setting can help performance when you are extracting a large number of 

records. By default, for single table queries, QUERY calculates the optimum chunk value for the 

run based on query characteristics, such as total field length and number of records to extract. 

With the data chunk value set, QUERY fetches only the number of records for each chunk that you 

can specify. The maximum allowed value for chunk size is 450000. A Stop button also appears so 

that you can stop the extraction if it is running for too long. 

Data chunk value is not available for Infosets/SAP queries. 

Run as SAP Background Process: Select this to for a cleaner run to keep the data file closed 

during the run.  

Enable adaptive query throttling: Available only when the administrator grants permission. 

When the throttling algorithm is applied, query execution slows as the system load increases; 

however, without the algorithm, the query executes in constant time and competes for resources 

with other transactions on the system. 

Adaptive query throttling is not available for logical databases or for infosets and SAP queries. 

Note: Although disabling this option while running the query can improve the query performance, 

the risk is that it can crash the server when it is already overloaded. Hence, we recommend that 

you always run queries with this option enabled unless it is certain that the SAP server is not 

highly loaded. 

Link QUERY script: Select this check box to enable linking of QUERY scripts. In the text box, 

specify the name of the next QUERY script to be linked.    

• You can click (Search button) to find the next QUERY script as needed.  

• Data File Carry Settings: In addition to specifying the QUERY script name, you can also mark 

which execution settings are to be carried forward to the next QUERY script by using any of these 

checkboxes: 

o File: Use the same data file. 

o Sheet: Use the same sheet. 

o Start Row and No of Records: Use the same Start and Number of Records. Both Start 

and No. of Records settings are carried forward together. 

Approval process for linked scripts 

 You can send linked scripts for approval, but only one review process applies to all scripts.  

 You can run a linked script from Excel.  
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 If no data-review is required, you can run the data sheet for linked scripts from QUERY.  

Validating linked scripts 

Linked scripts intended for Excel output can be validated. Validation on linked scripts is possible 

for the following configurations:  

 Column-based mapping and cell-based mapping in Excel forms. 

 Column-based files linked to cell-based files and vice versa. 

If the second file uses cell-based mapping with loops, you are prompted to provide the name of 

the log column before the second file runs. 

Linked scripts with run time variables 

You can link query scripts with multiple run time variables. While running the linked query scripts, 

QUERY prompts you to enter run time variables for each of the linked script file.  

The Run time variable wizard displays the fields to enter values of variables. You can type in the 

values manually or fetch the values from SAP using the browse button .  

 

Note: Linked query script files must be in production status before they can be scheduled for 

running. 

Result file options (not available for Winshuttle SERVER) 

Save and close output file after run: Click to save the contents of the data file and close it 

after a data download. 

Warn if data is present on result file: Click to be warned if there is already contents in the 

output file. You are given the options to save as a new file, Cancel, or write to the file. Writing to 

the file presents three more options, which you can also set in the Data writing options. 

Write header information on result file: Not available for Access or text files. 



 

 

Write field expression: Available only for queries from a single table or output to a text file. 

Selecting this option writes only the field name to the header and not the table name. 

Write field expression is always selected for logical databases and for infosets and queries, and 

you cannot change this setting. 

Data writing options 

Clear mapped columns or Clear result file: Clear mapped columns clears data from the start 

row to the end row of sheet or column. Available only for Excel files. 

Clear result file clears all contents from a file or table. Available for SharePoint lists, text and 

XML files, and for Access and SQL Server tables. 

Append data to result file: Appends data to the existing data. Not available for XML files. 

Overwrite existing data: Overwrites the data. Available only for Excel files. 

 





 

 

Managing QUERY 

Scheduling a query run 

You can schedule unattended queries. QUERY requires that your Connect log in information is 

saved. If you did not select Remember my login information when you logged in to Connect, you 

are prompted when you select an option that runs later.  

To schedule a run 

 Under Run options, click Run later or Run later (SERVER), and then click Run.  

The Schedule Run wizard appears. Follow the steps to schedule a query run. 

To complete the Schedule Run Wizard 

1. Do one of the following: 

o Click Capture SAP details to automatically retrieve the information that is selected on 

the SAP Logon dialog box. Clicking Capture is the easiest and most error-free method 

for adding logon details to the scheduler. 

-or- 

o Type in the required information in the fields. 

SAP System Name Specify the SAP system 

name 

Application Server Host Enter the host name. 

System number Specify the system 

number. 

Use Logon Group 

Select this check box to 

update logon group 

information. 

Logon Group If available, type the 

auto logon group 

information. 

Message Server Host If available, type the 

message server host 

information. 

Use SSO1 

Select this check box to 

enable single sign on. 

With single sign on, the 

SAP system uses the 

Windows credentials 

(user name and 

password) for each user.  

Partner Specify this connection 
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parameter if you select 

single sign on. 

Client Enter the client number. 

User name Specify the user name. 

Password 
Specify the SAP 

password for the user. 

Language 

Specify the language 

that the system should 

use. 

EP URL 
If available, specify the 

enterprise portal URL. 

E-mail notification 

Type the e-mail address 

for the person who you 

want to receive 

notification by e-mail 

message when the 

scheduled run is 

completed. You can 

specify multiple e-mail 

addresses that are 

separated by semicolon. 

Attach data file to the mail 

Select to attach the 

results file to the e-mail 

message. 

Run on console 

Run on console is 

selected by default. This 

setting cannot be 

modified. 

2. Click Test to confirm that your logon information works. Click Next. 

3. On page 3, select the following options: 

Perform this task: 

Once: Schedules a one-time run. If you select 

Once, you can set the Run on date. 

Daily: Schedules a daily run. 

Weekly: Schedules a weekly run. If you select 

Schedule Weekly, enter the weekly frequency. 

You can also specify the day of the week for 

the run. (The Weekly setting is not available for 

SQL Server.) 

Monthly: Schedules a monthly run. If you 

select Schedule Monthly, enter either the date 

each month for the run or the ordinal date. You 

also mark the months for the run. 

Run as 
If you want the task to run even if you are not 

logged on, enter your Windows user name.  



Managing query files 

 

95 

 

Start Time 
Select the time of day when the scheduled task 

is to take place. 

Password 
Enter the password the user provides to log 

onto Windows. 

Run only if logged on 

When selected, the user must be logged on for 

the scheduled task to be completed. This 

setting is not applicable for Windows 7. 

 
 

Managing query files 

The query manager provides a way to see an overview of the most relevant query files and to 

search for relevant query files on your computer. 

To open query manager 

 On the Most Recent Files and Favorites pane, click Query Manager . 

To see details of a file 

 Click a file in the List of files pane on the left to see its details appear in the main pane. 

To search for a file in within a file or across Query Manager 

 Type a user name, a field, a table name, or a date, and then click Search. You can use wild 

cards. The returned files are listed in the main pane. 

To open a file in Query Manager 

 Double-click on a file in the list in the left pane or main pane to open the file in the three-

pane screen. 

To delete a query file 

1. In the List of Query Files, right-click the file you want to delete. Click Delete Query. 

You are prompted to confirm whether you want to delete the file. Click Yes. 

 





 

 

Production server warning 

Production server warning (Prod. Svr. Warning) 

You might not want to run critical data on a production server. With the Production server warning 

box, you can maintain a list of SAP production servers. Each time you log on to a listed production 

server, a warning appears to remind you that this is a production server. 

To display production server warnings 

1. On the Tools tab, click Options . 

2. Click Prod. Svr. Warning. 

3. To see a list of available servers, click Add. 

4. In the SAP Logon pad, select the server you want to add, and then logon with your user 

name and password. 

5. The server is added to the list. Do this for every server you want to add. 

6. To enable the warning, select the Enable Warning check box.  

To delete a server from the production server warning list 

1. On the Tools tab, click Options . 

2. Click Prod. Svr. Warning. 

3. Select the server you want to delete from the list, and then click Delete. 

 
 

Customizing QUERY 

Application Defaults 

In QUERY, you set options from the Options button on the Tools tab. 

The Application Defaults settings contain: 

Path defaults 

Type any of the default file paths for the following files: 
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 Result files: specify Excel, Access, or text 

 Query files (.qsq files) 

 Log files and trace files 

 Auto logon file 

 Data Dictionary. You can set the location where the data dictionary is saved. You can even 

save to a location on a network. Ensure that you have read/write permissions for the folder 
that is set as the data dictionary location. 

 

Microsoft Excel defaults 

Sheet name: Default Excel sheet to use when running your query file. The default is Sheet 1. 

Start row: The default row is 2. 

Log Column/Cell: Specify the default column or cell into which log information is written. 

Disabling and enabling the RUNNER add-in 

If Excel files take a long time to open or if the add-in is incompatible with the Excel add-in or with 

other applications. 

 Click Disable Runner Add-in. 

Other defaults 

Default number of records to download: Specify the default number of records for each download. 

Error management 

To use error management tools 

 Select Tools from the Main Menu, and click the Options button to display the Options 
window, and then click Error Management. 

Trace 

The trace log can be used to help find the cause of problems you might experience with the 

program. When this option is enabled, it traces all the actions you have taken in the software and 

writes them to a file. The trace file is available under C:\Users\<user name>\My 

Documents\Winshuttle\QUERY\LOG or at your default path for log files. 
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If you experience a software problem, check the trace option and repeat the actions that resulted 

in an error. A text file is created in the default log folder that you can send to the support team for 

review. 

Note: It is important to shut off trace after you have the information you need. The log file will be 

written to continuously, which may degrade the program's performance. 

 





 

 

Viewing logs 

The QUERY Log Viewer provides you with a comprehensive log of all successful queries. You can 

view logs by clicking Log viewer on the Tools tab. 

To view logs 

 On the Tools tab, click the Log viewer button. 

To sort on any log fields 

 Click a field name. 

To export log information to an Excel file 

 Click Export. 

To filter listed query files 

 In the Filter box, select one of the following: 

o All to display all query files. 

o IP address: Port for a server to display all files that were run on that server. 

o Local to display all files that were run on your computer. 

The log viewer shows the following fields: 

Query file name The name of the .qsq file. 

SAP user name The name of the user who created the file. 

Download date The date on which the query was run. 

System The SAP system on which the query was run. 

Records The number of records extracted. 

Execution time The length of time it took to complete the download. 

Tables used Tables used to create the query. 

Selection Fields The fields used in the actual query. 

Output fields Fields included in the report. 

Run Reason Displays the Run Reason that was entered on the Run pane for this query file. 

Client The number of the client on which the file was created. 
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Unsuccessful queries 

Provided only when the destination type is SQL Server or when the query is run in scheduled 

mode. The unsuccessful queries are marked in red. Click the record to view the reason why the 

query failed. 

 

 

 

 

 



 

 

Working with Winshuttle Connect 

Winshuttle STUDIO and Connect 

If you have a Winshuttle Studio installation, when you log in and select Remember my log 

in for one program, Connect remembers your credentials for all programs.  

Concurrent logons 

It is possible to log in to two computers at the same time. When you log in to the second 

computer, a message appears to tell you that you are logged in twice, but it disappears, 

and you can continue to work. You cannot log in to a third machine. For more 

information, contact your Winshuttle Connect administrator. 

If your Internet is disconnected 

Full functionality is available for your programs through Connect for up to 6 hours after 

the Internet is disconnected. However, you must have authenticated once before the 

disconnection, so that it is clear to Connect that you are a valid user. The authentication 

requirement prevents unlicensed users from working offline. 

 

If your Internet is disconnected, you are notified in the status bar.  

 

However, the status bar may indicate that your license is still online. You can keep 

working, or save your work and sign out.  

Viewing Connect messages 

You can view updates, warnings, and other messages by clicking the Connect Message 

icon in the status bar.  

 

The Connect Message box in a client. 
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Signing in as a different user 

It is possible to sign in as a different user from the same computer, if that user name is 

properly provisioned with a current license. 

To sign in as a different user 

1. On the Most Recent Files and Favorites page, click the Welcome 

arrow , and then click Sign in as a different 

user . The Connect login dialog box appears.  

2. Click User credentials.  

3. Type the user name and password. Click OK. 

Changing proxy settings 

You can change proxy settings from within the client or from the login box. For more 

information, see Client Connection Settings. 

 

 



 

 

Advanced features 

Administrator options 

Administrator options are password protected. The default password is queryshuttleadmin. It is 

recommended that you change the default password to a unique password. 

To edit admin options 

1. On the Tools tab, click Options . 

2. Click Admin Options. 

3. Type the password. Click OK. 

To allow users to create and remove joins between tables 

 Select Enable Creation of Joins in Query Builder. 

To allow users to create joins on cluster and pool tables, and on views 

 Select Enable joins for cluster, view, pool tables. 

To enable the use of Infosets and SAP queries 

 Click Enable Infosets/SAP queries. 

To enable left outer joins 

1. On the Tools menu, click Options. 

2. In the left pane, click Admin Defaults. 

3. Select the Enable Left Outer Join check box.  

To allow all records to be downloaded 

 Select No Limit On Records to Download. 

To enable adaptive query throttling 

 Select Enable adaptive query throttling. The setting is enabled by default. 
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To allow users to manage string padding of criteria 

 Select Allow users to manage string padding of criteria. 

To specify the maximum number of records a user can download 

 In the Max. number of records to download box, type the number you want. The default is 

1 million records. 

To specify the maximum number of tables a user can add to the query builder 

 In the Max. number of tables in query builder box, type the number you want. The default 

is 4 tables. 

Query execution time-outs 

You might have to specify the length of time that QUERY waits during a query execution before it 

times out. 

To set a query execution time-out 

 In the Query execution time-out box, type how many seconds you want QUERY to wait 

before it times out. 

NOTE: If you have the Winshuttle function module installed on your SAP server, you can maintain 

the query time-out centrally by maintaining it in the table /WINSHTLQ/QREPRM. If you set this 

value both on SAP and on the QUERY client, the lowest duration of the two is chosen. 

Changing the admin options password 

To change the admin options password 

1. Select Change Password. 

2. Type your old password. 

3. Type your new password. Type the new password again to confirm. 

Editing SAP authorization objects in QUERY 

When you work with an SAP system that does not have the QUERY function module installed, you 

must add the authorization objects for each user so that organization level security is maintained. 

You can edit or delete the authorization objects from within QUERY. 



Adaptive query throttling 

 

107 

 

To edit authorization objects 

1. Click the Edit SAP Authorization Objects link. 

2. In the Authorizations pane, locate the object you want, and then click Edit. 

To delete an authorization object 

 In the Authorizations pane, locate the object you want, and then click Delete. 

To add a new row for a new authorization object 

 Click Add a new row. 

Adaptive query throttling 

The administrator must give permission for this setting to be available to users. The user setting 

appears in the Advanced Run Options pane. 

Using a patent-pending algorithm, QUERY adaptively throttles the execution of the query on the 

SAP server based on the current load on the SAP server. The available server resources are 

calculated from the total number of open dialog processes. When over 50 percent of the dialog 

processes on the SAP system are available, the query is executed at full speed, but when the 

available server load starts falling below 50 percent, the execution of the query is dynamically 

slowed. 

Adaptive throttling addresses the performance concern around querying on a live transactional 

system that query execution could take substantial computing resources that might compete 

against regular SAP transactions, and adversely affect the performance of these transactions. 

QUERY addresses this issue by allocating only available compute resources to execute queries in 

the live SAP system. 

The graph below shows the query performance time against the system load with and also without 

the adaptive query throttling algorithm applied. When the throttling algorithm is applied, query 

execution slows as the system load increases; however, without the algorithm, the query 

executes in constant time and competes for resources with other transactions on the system. 
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Note: Although disabling this option while running the query can improve the query performance, 

the risk is that it can bring down the server when it is already overloaded. Hence, we recommend 

that you always run queries with this option enabled unless it is ensured that the SAP server is not 

highly loaded. 
 

Authorizations 

Required SAP Authorizations in QUERY 

QUERY fully protects SAP security features. Under no circumstances can QUERY override the SAP 

authorization restrictions you are bound to. This document can help you and your security team to 

understand the SAP authorizations that are required to work with QUERY. In most cases, these 

SAP authorizations are already in place. This document can also help if you have tried QUERY, but 

cannot use it, or if you see error messages. 

Remote Function Calls (RFC) Authorization 

QUERY makes RFC calls to SAP. RFC access must be assigned. In most cases, these authorizations 

are already assigned to you. To work with SAP, the following objects with the indicated values 

should be in your SAP user profile. 

For the S_RFC Authorization Object: 

• Field RFC_TYPE - FUGR (function group) 

• Field ACTVT - 16 (execute) or * 
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• Field RFC_NAME - * 

Table Level Authorization 

To access a specific table in QUERY, you need table level access. Table level access in SAP is 

independent of a transaction. For example, you may have access to the transaction MM01 which 

uses the Material Master table (MARA), but this does not give you automatic access to that table. 

Table level access is controlled by these authorization objects: 

• S_TABU_DIS for client dependent tables 

• S_TABU_CLI for client independent tables 

Almost every client dependent table in SAP is assigned to a specific authorization group in the SAP 

table TDDAT, field CCLASS. For example, table MARA is assigned to the authorization group MA. 

To access Table MARA, authorization group MA must be assigned to your SAP profile in the 

authorization object S_TABU_DIS as indicated in the following example: 

Authorization Object: S_TABU_DIS 

Fields: Authorization group ( DICBERCLS) - MA (For table MARA) 

Activity ( ACTVT) - 03 (Display) 

Notes: 

1. Each table may belong to a different authorization group. For you to access different 

tables, your profile must have the proper authorization for the appropriate groups.  

2. For client independent tables (where the field MANDT is not present in the table), you need 

the following authorization object in your SAP profile: 

Authorization Object: S_TABU_CLI 

Field: CLIIDMAINT - X 

3. To attaining the specific authorization group, if your required table is not listed in the SAP 

table TDDAT, you must make the following assignment: 

Authorization Object: S_TABU_DIS 

Fields: Authorization group ( DICBERCLS) - &NC& 

Activity ( ACTVT) - 03 (Display) 
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Windows error messages 

If the file you are trying to run contains macros, you may receive a security warning.  

To enable macros in Excel 2003 

1. Click the Tools menu. 

2. Click Macro, and then click Security. 

3. On the Trust Publishers tab, click Trust all installed add-ins and templates. 
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